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LOG IN TO AXXESS 
Navigate to www.axxess.com. Select CLIENT LOGIN 
 

 
 
User inputs credentials and selects Secure Login. 
 

 
 

AXXESS PLANNER 
The Axxess Planner displays pertinent information specific to a user. Shortcuts 
have been placed on the left side of the page to allow for easy access to the 
Axxess applications the agency is using. Clinicians can also see upcoming visits, 
past due visits, unread messages, and a map of today’s visits. To access patient 
charts, document a visit or bill for an individual patient, select the appropriate 
Axxess application on the left side of the page.  
 

 

http://www.axxess.com/
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NAVIGATION MENU 
Once logged in, the navigation menu at the top will allow for easy access to the 
data.  
 

 
 

Home 
The Home menu allows access to the following actions based on permissions 
granted to the user. 
 

 
 

My Account – Users can quickly edit their profile, reset their signature or switch 
to different Axxess applications. 

 

 
 
 

My Dashboard – This opens the Axxess Home Health dashboard. 
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My Messages – This opens the Message Center to view/send messages. 
 

 
 

My Schedule / Tasks - View the schedule/tasks in a list view. 
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My Monthly Calendar - View the schedule/tasks in a monthly calendar view. 
 

 
 

My Pending Co-Signature Notes - Sign notes that are marked to require a co-
signature. 
 

 
 
Quality Assurance (QA) Center - View tasks that are pending approval by the 
QA Nurse. 
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EVV Exception Center – Enables users to manage, correct and resubmit EVV 
exceptions data. 
 

 
 

Create 
The Create menu allows access to the following actions based on permissions 
granted to the user. 

 
 

New - Add new items into the system, such as a Referral, Physician, 
Communication Note, etc. 
 

 
 

OASIS Export - View OASIS assessments that are ready to be exported and 
submitted to CMS. 
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View 
The View menu allows access to the following actions based on permissions 
granted to the user. 

 
 
Lists - View items in the system, such as a list of Referrals, Patients, Physicians, 
Insurances/Payors, etc. 
 

 
 



9 

 

 

Blank Forms - View blank versions of visits to be printed and filled out manually. 
 

 
 
Archived Insurances - View insurances that are no longer in use. 
 

 
 
Exported OASIS – Review or cancel any previously exported OASIS or edit 
correction numbers. 
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Not Exported OASIS - View OASIS that were not exported from the system. 
 

 
 

Past Due Recerts - View patient recertifications that are past their due date. 
 

 
 
Upcoming Recerts - Review patients that have an upcoming recertification date 
within the next 30 days. 
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Orders Management - View orders that are pending co-signature, pending 
physician signature, orders to be sent and orders history. 
 

 
 
Print Queue - Displays tasks that are ready to be printed and delivered to the 
appropriate recipient. 
 

 
 

Patients 
The Patients menu allows access to the following actions based on permissions 
granted to the user.  

 
 
 

Patient Charts - View patient charts within the system, including active, pending, 
discharged and non-admitted patients. 
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Existing Referrals - View a list of pending referrals and begin the admission 
process. 
 

 
 

Pending Admissions – View, edit, add, non-admit and add notes for pending 
admissions into the system. 
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Non-Admissions – An inclusive list of all non-admissions logged in the system. 
From this screen, a user can also admit a patient if they were mismarked. 
 

 
 
Deleted Patients - Patients who have been deleted from the system are visible 
on this screen and can be restored, if necessary. 
 

 
 

Hospitalization Logs - Patients who have been transferred to the hospital by 
completing a Transfer OASIS are visible on this screen for tracking purposes. 
New hospitalizations can also be entered from here. 
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Pre-Claim Review Center - Enables agencies to efficiently and seamlessly 
collect and track their PCR submission documents. 
 

 
 
 

Schedule 
The Schedule menu allows access to the following actions based on 
permissions granted to the user. NOTE: See Intake/Scheduling manual for 
further details. 
 

 
 

My Schedule / Tasks - View the schedule/tasks in a list view. 
 
My Pending Co-Signature Notes - Notes that require a co-signature will be 
listed in this section until signed by the responsible co-signer. 
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Schedule Unassigned Visits – Enables users to view all episodes with ordered 
visits that have not been fulfilled and seamlessly schedule all frequency orders. 
 

 
 
Schedule Center - Review a patient’s schedule as well as completed visits and 
miscellaneous episode information. 
 

 
 
Reassign Schedule - Reassign an employee’s schedule to another employee 
for a specified date range. 
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Unscheduled Visits Report - This report alerts agencies to assign and schedule 
visits according to the ordered visit frequency. 
 
Schedule Report - Generate a schedule report by Status, Discipline, Clinician or 
Patient. 
 
Schedule Deviation Report - This report will display visits that were completed 
outside of the originally scheduled date.  
 

AxxessCARE  
The AxxessCARE menu allows access to the following actions based on 
permissions granted to the user. 
 

 
 
AxxessCARE Scheduler - Post multiple visits to AxxessCARE that require 
coverage. 
 

 
 

Posted Visits Summary - Review the visits that have been posted to 
AxxessCARE along with their current visit status and assigned clinician. 
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NOTE: Only specific state agencies will have the option to “Post to 
AxxessCARE.” Other states are coming soon. 
 

Billing 
The Billing menu allows access to the following actions based on permissions 
granted to the user. NOTE: See Billing manuals for further details. 
 

 
 

AxxessDDE – If the agency has access to AxxessDDE, applications can be 
switched here. 
 
DDE Black Screen – Opens a new browser tab to access to DDE Black Screen. 
 
Billing Center – Enables users to manage all billing processes in a central 
location and streamline operations to ensure timely claim submissions. 
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Pending Claims – Provides a centralized location for managing all Medicare and 
Managed Care claims that have outstanding balances. 
 

 
 
Medicare / Medicare HMO (PPS) - This menu provides the options to create 
claims, view claims history and review eligibility for Medicare/Medicare HMO 
clients. 
 
Managed Care / Other Insurances - This menu provides the options to create 
claims and review claims history for Managed Care/Other Insurances. 
 
All Claims - A central location to review claims regardless of insurance or bill 
type. 
 
NOTE: Claims with a start date on/after January 1st 2020 are required to be billed 
from Billing Center 
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Claim Submission History - Review submitted claims and the associated 
responses by Batch ID. 
 
Remittance Advice - Review notices of remittance and electronic fund transfers. 
 

 
 

Admin 
The Admin menu allows access to the following actions based on permissions 
granted to the user. NOTE: See Admin manual for further details. 
 

 
 

New - Add new items into the system, such as a Referral, Facility, Pharmacy, 
Insurance/Payer, etc. 
 
Lists - View items in the system, such as a list of Referrals, Patients, Physicians, 
Insurances/Payers, etc. 
 
Deleted Users - Users who have been deleted from the system will appear on 
this screen for historical purposes. These users may also be restored from within 
this screen.  
 
Payroll Export Center - Enables users to generate robust payroll reporting, 
export ADP (.csv) and Paychex (.txt) vendor files and streamline payroll 
processing and operations. 
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Accelerated Payment Center - Provides forms, resources and information to 
help agencies apply for accelerated payment. 
 

 
 
Non-Visit Activity Manager - A central entry point for non-visit activity as well as 
the ability to mark as paid. 
 
License Manager - A central location to review all licenses entered into the 
system as well as the ability to “Add Non-User License” to the system. 
 
Custom Note Manager - Custom notes created from a system-generated note 
are visible from within this screen and allow the ability to rename a note. 
 
Company Setup - Company-wide settings and information are managed from 
this screen. NOTE: An Administrator/DON (permission based) signature is 
required to access this screen.  
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Reports 
The Reports menu allows access to the following actions based on permissions 
granted to the user. 

 
 
Report Center - Provides access to reports available within the system. 
 

 
 

Completed Reports - Some reports will be queued until compiled. Once the 
data has been compiled, the report will be available from this section.  
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Help 
The Help menu allows access to the following actions based on permissions 
granted to the user. 

 
 

Social - Connect with Axxess on social media using the quick links provided in 
this menu. 
 
ICD-10 - Reference material for ICD-10 including a lookup and an ICD-9 to ICD-
10 crosswalk are available from this menu. 
 
Live Training Webinars – A link to in-depth training videos to help users get 
started in the Axxess Home Health, Home Care and Hospice products. 
 
Support & Training - Allows access to the Help Center and the Axxess 
Community. 
 
Recent Software Updates - To see recent software updates, please use the 
Resolution Center listed above in the menu. 
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COVID-19 Resource Center - A direct link to the Axxess COVID-19 Resource 
Center which includes Best Practices, Hear From Experts, Helpful Downloads, 
Personal Protective Equipment (PPE) and Helpful Links. The page can also be 
found by going to www.axxess.com/covid-19 
 

RESET SIGNATURE 
Home/My Account/Reset Signature 
 
A new window will display, as seen below. Select Reset Signature and a link will 
be sent to the email address associated with the account. Review the system 
generated email sent to the user’s email address for a personalized link to reset 
the signature. Upon selecting the link, a screen will appear in the web browser 
prompting the user to verify the information and enter a new signature. 
 

 
 

 
 

After inputting a new signature, select Change signature and a prompt will 
display to confirm the change was successful. Close the internet browser window 
and log back into Axxess to use the newly updated signature. 
 

RESET LOGIN PASSWORD 
To reset the Axxess login password, follow one of the methods listed below. 
 

http://www.axxess.com/covid-19
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Current Login Password is Unknown 
Navigate to the login page and select Forgot your Password? Continue to 
follow the prompts to enter the email address used to log in to Axxess and select 
Send. This will send a password reset link to the user’s email address.  

 
 

Current Login Password is Known 
 

 
 
Home/My Account/Edit Profile. On this screen, input the current password and 
new password desired in the boxes provided. Select Save to confirm the change. 


